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What's new in Topicscape Pro 2.0 (currently in Beta) 

 

New items since Feb 26
th

 Beta version are highlighted 

 

 Tagging (added edit or delete tags throughout Topicscape) 

 Halo menu and associated dynamic help 

 Innovative swinging panels 

 Topic footprints 

 Keep Topicscape active but out of view 

 More Association line choices 

 Topic name layout improvement 

 Hotkeys on menus 

 Neighborhood views 

 Customize the Home view position 

 Choose different skins for different Topicscapes 

 License installer 

 Additional demo 

 Two new zoom options 

 Delete a Topicscape 

 PB import update 

 Topicscape Pro Beta 2.0  --  administrative details 

 Bug fixes 
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Tagging 

There are several 'big deals' with version 2.0 but the biggest for some will be 

tagging.   

We've had many requests from users wanting to be able to tag topics ... we 

listened … and now you can do it.  Not only topics but occurrences as well. Any 

topic or occurrence can have tags - up to ten - and these tags provide a new way 

of finding things: tag filters.   

When you apply a tag filter, in the 'Scape you will see only topics matching the 

tags that you filtered on.  The others disappear until you turn the filter off.  

Matching occurrences appear in the Topic Center in bold italics, for easy 

identification. 

This means that you can tag things as, say, "urgent", "personal", "do with Jenny", 

"delete on Dec 31", "marketing", "blog", "reading" or "check".  The tags are 

independent of the hierarchy or other structure. 

So, let's say Jenny walks in the room.  You apply the "do with Jenny" tag filter and 

all you see in your Topicscape are the items to work on together and you can get 

down to work with all the material you need but without distraction. 

A tag filter is a type of search.  As with other searches, the matching items all 

appear in the Hit List, but there's another place to see the results of applying a tag 

filter: The tag pool.  This is to the left of the Hit List and shows all tagged items 

filtered in - topics and occurrences - set out alphabetically in 3D ranks. 

There are several ways of working with tags in Topicscape.  You can use 

keyboard shortcuts, the new Halo menu, the main Edit menu (Search) or 

a new button on the Details panel.  The Halo menu appears when you 

hover over a topic (see example on the right) and is described in the next 

section. 

For simplicity at first, we will mention just one tag control for each operation.  For 

full details of tag controls, see All the controls at the end of this section. 

Adding or removing tags 

To tag topics, click on the tag icon in the Halo menu.   

This will show a tag cloud with any tags already selected for that item 

highlighted in orange (see next page).  The tag cloud will include all tags you 

have already used in this Topicscape, plus the standard tags (see Mechanics of tags 

below).  The more frequently used a tag is, the larger will be the lettering, and it 
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may be bold. 

The cloud appearance has been greatly improved.  A Beta user stung us into 

action when he gave them a valid description: 'twinky'.  We appreciate 

constructive criticism - thanks Ian! 

To add a standard tag, 

or a tag that is already 

used somewhere else in 

this Topicscape, just 

click on it.  

To remove the tag on a 

topic, click the high-

lighted word and the 

highlight will disappear. 

To add a new tag, one that's not already in the cloud, type it in the text box and 

click the Add button.  Then click OK.  See below for information about the second 

option with this panel, changing tags throughout the open Topicscape, which is 

controlled by the radio button at the top. 

The Clear button is used when you want to clear all tags already assigned to this 

topic.   

To tag occurrences, select the occurrence and click the Tag button at the top left 

of the Details Panel.  The same tag cloud will appear.  You can select multiple 

occurrences in the Topic Center and tag them in once operation. 

Filtering by tags 

Bring up the tag cloud by clicking the tag button in the toolbar.  The tag cloud 

that appears is a little different to the previous one, because it's designed for 

searching, not for modifying tags. 

In the tag cloud, you will see all tags you have already used in this Topicscape.  

Choose the tags you want 

to be included in the 

results, decide if you want 

to filter by occurrence or 

topic only - checkboxes 

are provided for that - and 

press the "Filter" button.   

If you are inspecting an 

item's tags in its tag 

bubble (see below) and 
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you want to see what other items are tagged the same way, the controls are right 

there in the tag bubble.  Simple click on the tags you're interested in, and click the 

Filter button. 

Viewing the results 

After applying a tag filter, you will see the Hit list as usual, with items matching 

the chosen tags.  A topic containing an occurrence with a matching tag 

will appear in the list, even if it does not have a matching tag itself.   

Or you can press Ctrl+3 to see the Tag Pool.  The items associated with 

the tags you chose, topics and occurrences, are shown there arranged in 

ranks.   

If you press the Home key, you will see the 'Scape, with only the filtered-

in items showing.  Topics that are filtered out will leave empty 

spaces.  To provide a reference point, the Current Topic 

always remains visible. 

While a filter is in effect, you'll see a tag status bar near the 

bottom of the window that reminds you of the tags selected. 

Case sensitivity 

Tag filtering is case sensitive.  "Urgent", "URGENT", and "urgent" are different 

tags. 

Cancelling a filter 

If you press the Escape (Esc) key, the 'Scape will show all topics once again, while 

the Hit List and Tag Pool will still hold the filtered results. 

Inspecting an item's tags 

To see how a topic is tagged, you can hover over the tag 

icon in the Halo menu (see below) and a bubble will 

appear showing the tags assigned to that topic. 

To see how a topic or occurrence is tagged, whether the Halo menu is in use or 

not, select the topic or occurrence, and in its Details Panel, hover over the Tag 

button.   

Searching within a tag filter 

If a tag filter is in effect (which you will know by the tag status bar), you can do a 

search in the normal way, by just typing the search term.  However, the search 

will examine only items that match 

the tag filter.  To remind you that 

you have requested a search limited 
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by the tag filter, Topicscape shows a blue border round the search-term box. 

Changing tags throughout a Topicscape 

If you wish to make a global change to a tag word, or delete all references to a tag 

throughout a Topicscape, you can now do so. 

For example, you might want to change all references in the current Topicscape 

to the tag "Tuesday meeting" to "Sales meeting", or even delete all references to 

"Tuesday meeting".  This can now be done in one operation. 

First, press the radio 

button for "throughout 

this Topicscape", and the 

Add button will be 

replaced with Edit and 

Delete buttons. 

Key in the tag you want to 

change.  Then you can 

press Delete to remove all 

references to that tag 

anywhere in this Topicscape.  Or you can press Edit, and key in the replacement 

tag. 

The Mechanics of tags 

Tags that you add are linked to an individual Topicscape, rather than appearing 

in all Topicscapes on that computer.  This avoids having many irrelevant tags in 

all your Topicscapes. 

Tags are built up as you use them, but there are a few standard or default tags 

that are present even in a new Topicscape.  They are: calendar, contact, image, mail, 

money, personal, reference, task, today, urgent, web.   

When you drag in objects of specific types that Topicscape can identify, it will 

automatically tag them.  Examples of this would be image files, emails from 

Outlook, tasks from Outlook, and web page shortcuts or archives. 

All the controls 

The quick introduction above mentioned just one control for each function.  

Depending on what you are doing at the time, and whether you like to use the 

keyboard as much as possible or the prefer the mouse, you may want other ways 

of accessing the tag functions.  Below, you will find all of the tag controls listed, 

followed by a handy table. 

But we find that most of the time, the simplest way to handle tagging is 1, 2, 3!  
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Main menu Halo menu Details Panel

Item's tag 

bubble

Keyboard 

shortcut

Quick jump 

button

toolbar 

button

Add or remove tags. View tag cloud 

(assigned tags are highlighted)
n/a click tag icon

click tag 

button

click [ + ] 

button
Ctrl+1 - -

Filter by any tag used in that Topicscape
Edit | Search | 

Filter by tags
- - - Ctrl+2 -

Click tag 

icon

Filter by tags of selected item only - - -

select tags, 

click Filter 

button

- - -

View the tag pool
View  | Tag pool 

view
- - - Ctrl+3

click left-most 

button
-

View item's tags in its tag bubble (only 

tags assigned to that item are shown)
- hover over tag icon

hover over tag 

button
- - - -

That means Ctrl+1 to add tags to the selected topic, Ctrl+2 to filter by tags, and 

Ctrl+3 to go to the Tag Pool. 

Adding or removing tags: Select an item and press Ctrl+1;  or click tag icon in 

Halo menu;  or click "Tag" button on Details Panel;  or click  button in item's tag 

bubble.   

Filtering by tags:  Press Ctrl+2;  or Edit menu | Search | Filter by tags;  or select 

tag button in toolbar;  or click "Filter by tags instead" button in search panel. Then 

choose tags to be included from the tag cloud and press the Filter button. 

To filter on just tags in a specific item's tag bubble, select tags from the bubble and 

click its Filter button. 

Viewing results:  In the Hit list;  or press Ctrl+3 to see Tag Pool;  or press Home 

key to see 'Scape, with only filtered in items showing (topics that are filtered out 

will leave empty spaces).  Note: Topics that do not match the tag filter but contain 

one or more occurrences that do will be filtered in. 

Cancelling a filter: Press Escape (Esc) key;  or press Close button on tag status bar. 

Inspecting an item's tags: Hover over Tag button in Halo menu;  or Hover over 

Tag button on Details Panel. 

For reference: 

A note about tags from PB 

3D Topicscape Pro already imports tags from PersonalBrain.  They were not 

visible in 3D Topicscape Pro 1, but they were stored in the database.  They will 

now appear as tags in 3D Topicscape Pro 2, even if your PB files were imported 

by Pro 1. 
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The Halo menu 

The next big deal (we think) is the Halo menu.  Hover your cursor over a topic in 

the 'Scape or The Lists, and this forms in front of your eyes, giving immediate 

access to eight controls: 

 

Bear in mind that if you choose "Search this topic 

group", your search will look in only the topic on 

which the halo appears and all its descendants.    

To remind you that you have requested a search 

limited to a topic group, Topicscape shows an 

orange border round the search-term box.  For a 

full search, you just start typing the search terms, 

as you do now. 

Two controls have added capabilities on hover: 

Hover over the 'Enter Topic Center' icon (ringed 

in red in the illustration) instead of clicking it and 

you will see a simple list of the contents.  You can 

click on an item from that list to open it, if it has a 

file attached. 

Hover over the Tag icon and you will see the tags assigned to that topic. 

The Halo menu brings often-used controls into a highly visible position, and 

allows the right-click, pop-up menu to be simplified.  If you like, you can turn it 

off.  Existing controls still work, if you prefer. 
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This menu also has built-in 

dynamic help as you can see 

on the right.  Hover your 

cursor over an icon and the 

blue help bubble explains the 

icon's purpose.  It is headed by 

the topic's name, in case the 

name panel is covered by the 

Halo menu. 

There are checkboxes in the 

help bubble, to suppress the 

Halo Help and the Halo menu 

itself.  Switching them on 

again is done from the Options panel: 

Tools | Options | User Preferences | Enhanced Menus 

If you select a topic, it's Halo menu will disappear until you 

move the cursor away and back again to hover over the topic. 

The Halo menu shows anywhere in the 'Scape where a topic 

appears: Cones, pyramids, 3D Hit List and History list items 

(for topics, but not occurrences), and even the 2D lists. 

Swinging panels 

Then there are the Swinging Panels.  Adjust the appearance of 

Topicscape's landscape easily and without hunting through 

menus: 3D Topicscape Pro's new and innovative "Swinging 

Panels" provide a way of controlling software with the 

minimum obstruction to the view that is so important to 

quickly grasping where you are in your information 

landscape.   

Most of the time, the panels swing back and are only just 

visible, but move your cursor over them and they swing out to 

allow you to see them fully and use the controls.   

There may be two swinging panels, one on each side, though 

by default you will see only the one on the right.  Press Ctrl+h 

to trigger the other, which is the 2D hit list on the left-hand 

side. 



                 Some have a photographic memory . .  .  
                 the rest of us use Topicscape 

 

© 3D-Scape Limited, 2009 All rights reserved       9 February 2009 

Quick Options  

The swinging panel on the right of the Topicscape window, "Quick options", 

gives you fine control over many aspects of the appearance of the Topicscape 

scene, either through direct controls or by bringing up one of the tabs in the 

Options panel. 

2D Lists 

If you have chosen to view the Hit and History Lists in 2D,  the swinging panel 

on the left shows these lists.  As always, pressing Ctrl+h toggles between use of 

the 3D Lists and the 2D ones. 

Swing or pin open? 

If you want to have either or both of the swinging panels permanently 

in full view, click the small thumb-tack icon at the top of each panel.  

Transparency 

The transparency of the Quick Options swinging panel is controlled by the same 

spinner as controls the transparency the 3D/2D hit list (on the Skins tab of the 

Tools | Options panel). 

Topic footprints 

Now you can get confirmation of the 

'Scape's structure without a moment's 

thought: The topics in front of the 

Current Topic now have footprints to 

show how they are grouped.  

If you like to use different colors for 

topic cones, the color of the parent 

topic of each group will be used to 

shade the footprints.  Try the Festival 

skin (right) to see this. 

Keep Topicscape active but out of view 

To reduce distraction, you can have the Topicscape window auto-hide while you 

work on other tasks.  Topicscape has been capable of this for a while - until now, 

it has been an undocumented feature.   

This is  customizable option.  It defaults to OFF so this won't happen unless you 

select it.  Make sure you are in User's Mode, then in the tools menu, select 

Options | User Preferences | Minimize Topicscape's window when it loses the 

focus. 
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Then, when you click on another window, Topicscape will minimize to 

an icon in one corner.  Which corner it goes to is up to you.  It is 

initially set to go to the bottom right corner, but a small drop-down box 

near the "Minimize Topicscape's window" radio button allows you to 

choose.  

There are two ways to bring Topicscape back:  Either click once on the icon, or if 

you want to drag something into Topicscape, drag the file (or folder or favicon) 

over the corner icon but don't drop it.  The Topicscape window will be restored, 

and then you can drop it in the appropriate place. 

More Association line choices 

If you like to have a visible connection between related topics, there are now 

more choices of how you see association lines connected to the selected topic.  In 

addition to seeing just parent connections or no connection line, now you can 

also choose to see parent and child connections, or parent, child and sibling 

connections. 

This is controlled by four options under "Topic association lines" in the Quick 

Options swinging panel. 

As before, holding down the F7 key shows all association lines. 

Topic name layout improvement 

The name panels on Cones and pyramids are wider, so they are less likely to 

break words at unwanted places now.   

But better still, you can control hyphenation of long words in topic names on the 

cones as well.  Simply add soft hyphens with Ctrl+- when editing in the Details 

Panel.  The hyphens are only visible when Topicscape cannot fit the word on a 

line, or when you are editing the topic name in the Details Panel.  They show up 

as white hyphens with a blue background like this: This is a hyphen-ated 

example. 

Soft hyphens are only used in two circumstances:  

 If the name requires more than three lines  or 

 If a word is so long that it cannot fit on a line by itself 

The presence of soft hyphens in words will not affect searching.  So in the 

example given earlier, a search for 'hyphenated' would give a hit. 

Hotkeys on menus 

Like to keep your hands on the keyboard?  Long overdue, the menus now have 

hotkey operation - Alt key + a letter - so that you don't need to reach for the 
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mouse. 

There is a change to an old shortcut: Repeatedly pressing Alt+U cycles through 

many field textures so that you can choose your preference easily. (Changed from 

Ctrl+Alt+U.)  Don't forget that you can change the color of the field as well. 

Neighborhood views 

Want to find the tag pool quickly?  Or Topicscape Orphans, Topicscape Islands, 

the Lists, or the Home position?  There are shortcuts and menus for all of these, 

of course, but on the swinging panel there's a new way:  Five icons, shown here: 

give a quick jump to the neighborhood you want, with 

just a click. 

Customize the Home view position 

The new swinging panel affects the visible area a little.  We had adjusted the view 

point for the Home position to take note of that (including allowing for cases 

when you pin the panel open.  (You arrive at the Home position when you press 

the Home key.)  A user commented that the positioning was not as he wanted it.  

(Thanks for the prod Mark.)  

We have therefore introduced a new control near the foot of the 

Quick Options swinging panel.  You can permanently slide the 

view point in and out, and left and right to your taste.  The same 

proportional adjustment will be applied to the Home position 

for any Current Topic. 

You can only make this adjustment when you are at the Home position and as 

you move somewhere else, the control will be disabled and the Lock checkbox 

will be checked.  To adjust it again, press the Home key or uncheck the box, and 

your viewpoint will be taken back to the home position. 

Choose different skins for different Topicscapes 

In the past you had flexibility to choose one of 20 skins for your Topicscapes.  You 

could also make your own customizations to those by changes to topic shape, 

color, texture and transparency, as well as ground texture and color. And you 

could change again after a while if you were feeling adventurous. 

But any change you made applied to all your Topicscapes. 

Now, you can choose a skin for each individual Topicscape, while still being able 

to specify the standard (or default) skin that will be used for new Topicscapes, 

until you decide you want something special. 
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Once you move away from your standard skin you will see a warning "You are 

about to permanently disconnect the skin for this Topicscape from the standard 

(default) skin settings."  At that point you can confirm or cancel. 

License installer 

There is now an entry "License Loader..." in the Help menu that simplifies 

installing your license file when you buy Topicscape, or need to re-install.  Simply 

drag the attachment from the license email we sent you to your computer's 

Desktop, and select Help > License Loader... 

If your copy of Topicscape has expired, you won't be able to reach the Help 

menu, of course, so please use the alternative:   

Go to the Windows Start button > All Programs > Topicscape > Topicscape Pro 

License Loader 

This information is provided as a description of 3D Topicscape Pro 2.0.  It does 

NOT apply to (and will not work with) the Beta version, which has a fixed expiry 

date of March 31st 2009.  

Demo 

There is a new demo entry in the Help menu that shows new users how multi-

parent topics work.   

Two more zoom options 

1.  Following a user suggestion (thanks Vipin), we have modified the mouse-

wheel zoom so that rolling the mouse wheel zooms the scene towards the 

location of the mouse pointer in the Topicscape window.  Unless it is in the 

center of the screen, you will need to track the object as it moves 

If the mouse pointer is outside the Topicscape window, the scene zooms towards 

its centre, as it does in the present live version of Topicscape. 

2.  Existing users will know that if they hold down the Shift key and click on a 

topic cone, they will immediately zoom in to a convenient viewing point for that 

topic and its surroundings.  They will also know that depending on whether they 

release the Shift key or the mouse button first, they will either stay in that 

position or zoom back. 

Well, now the same applies to items in the 3D Hit and History Lists on the left of 

the 'Scape. This means that you can quickly zoom to a position to see the back 

items.  Some users prefer to use the 2D lists instead, but for those who like to 

keep working in the 3D environment, this new zoom is a convenience. 
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Delete Topicscape 

Drastic, but convenient for those who don't like digging around in Windows 

Explorer, is the new function that will delete a Topicscape. 

You can find it in the File menu.  This will delete the Topicscape database (3DT 

file), all the occurrence files in its folder, Description+ files and settings specific to 

this Topicscape (such as favorite settings).  This is an irreversible action, and it 

will warn you of that twice.  You cannot delete a Topicscape when it is open, so 

you must select another one first. 

To be clear, files that the Topicscape links to but which are stored outside its folder 

in My Topicscape, will not be deleted. 

PB import update 

Import of PersonalBrain data has been extended so that changes to the PB5 

database are handled, to acquire data that is not exported by PB itself. 

See also A note about tags from PB above. 

There is a special version of the PB Import Extender that installs in your 

Topicscape Beta folder if you try to do an extended import of a PB and check for 

an update. 

Topicscape Pro Beta 2.0  --  administrative details 

Period of use 

Topicscape Pro Beta 2.0 will work without a license until March 31
st

, whether you 

have previously installed Topicscape or not, whether you have a licensed version 

or an expired one. 

Live release 

We plan to release the live 3D Topicscape Pro 2.0 before that date.  Purchasers of 

earlier versions of Topicscape may need to purchase an upgrade license. (All 

versions of Topicscape Pro 1 will continue to function as now.) 

Conversion 

If you are still using an older version of Topicscape, the database may need to be 

converted - this will be done automatically, and the original database file will be 

retained. 

The converted database will still work on the current live Topicscape (version 

1.63), though of course, that version will not see any tags you have added and 

customizations new to 2.0 will not be visible. 
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Bug fixes 

Windows Desktop search on Vista 

When running under Windows Vista, Topicscape's capability to use Windows 

Desktop Search (WDS) for searching file contents, was broken.   

This has now been fixed. 

Editing in the Details Panel when brought up from minimized position 

When editing information in the Details Panel, it was possible to lose the changes 

made if the Details Panel had been minimized and was brought up for editing by 

hovering over it.  This now does not happen.   

Also there could occasionally be a problem with similar editing when the large 

text panel was used (by pressing Shift+F2 while in text editing mode). 


